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Preface 
 

Copyrights 
Office Hours Professional Patient Appointment Scheduler and documentation 
Copyright Copyright © 2008 McKesson Corporation and/or one of its subsidiaries. All 
Rights Reserved. 

Software License Agreement 

License Agreement  
NDCHealth Corporation d/b/a McKesson Provider Technologies (“McKesson”) grants 
to the original purchaser ("Purchaser") a nontransferable, nonexclusive license to use the 
accompanying software (the “Software”) in machine-readable, object code form only, 
and the associated documentation for the private use of Purchaser as set forth in the 
Permitted Uses and Prohibited Uses sections below.  Acceptance and use of the Software 
acknowledges Purchaser's agreement to abide by the terms of this License Agreement.   

Disclaimer 
McKesson makes no representations or warranties with respect to the contents of the 
Software and specifically disclaims any implied warranties and warranties of 
merchantability or fitness for any particular purpose.  McKesson reserves the right to 
make changes or alterations in the Software without the obligation to notify anyone of 
the changes or alterations. 

Permitted Uses  
Purchaser may (1) copy the Software for backup purposes to support Purchaser's use of 
the Software; (2) use the Software on a single computer; and (3) if integrated with 
McKesson networked software licensed by Purchaser from McKesson, Purchaser may 
install this Software on each computer within one network at a single location. 

Prohibited Uses  
Purchaser may not (1) distribute, rent, sublicense, or otherwise make available to others 
the Software, documentation, or any copies thereof; (2) modify, translate, adapt, 



 
ii     Office Hours Professional 

disassemble, or create derivative works from the Software or documentation; or (3) use 
the Software or permit it to be used on more than one computer at any one time, except 
as expressly authorized in the Permitted Uses Section above.  The Software, 
documentation, and all manuals accompanying the Software are copyrighted and all 
rights are reserved by McKesson.  No copyrighted material may be copied, photocopied, 
reproduced, translated, or reduced to any electronic medium or machine-readable device 
without prior written consent from McKesson.  

McKesson’s Rights 
Purchaser acknowledges and agrees that the Software and associated documentation are 
proprietary products of McKesson and certain third parties (“Third-Party Licensors”) 
protected under U.S. and international copyright law.  Purchaser further acknowledges 
and agrees that all right, title, and interest in and to the Software and any copies thereof, 
including associated intellectual property rights, are and shall remain with McKesson 
and Third-Party Licensors.  The License Agreement does not convey to Purchaser any 
interest in or to the Software, but only a limited right of use revocable in accordance 
with the terms hereof, and Purchaser agrees to transfer to McKesson any property 
interests or rights in the Software Purchaser may have or later obtain by operation of law 
or otherwise which are inconsistent with the rights granted to Purchaser herein.   

Trademarks 
All other trademarks associated with the Software are trademarks owned by McKesson 
or Third-Party Licensors.  No right, license, or interest to such trademarks is granted 
hereunder, and Purchaser agrees that no such right, license, or interest shall be asserted 
by Purchaser with respect to such trademarks.  Purchaser agrees not to take any action 
which would damage the goodwill associated with any such trademarks.  

Limited Warranty  
McKesson warrants to Purchaser that the computer media on which the original 
Software is recorded will be free of defects in materials and workmanship for a period of 
thirty (30) days from the date of purchase under normal conditions of use and service.  
Should the media become defective within thirty (30) days from the date of purchase, if 
proof of original purchase can be verified, McKesson will replace the Software or, at its 
option, McKesson may refund to Purchaser the original McKesson purchase price.   

McKesson, its software suppliers, distributors, and Value-Added Resellers make no 
representations, warranties, or guarantees, express or implied, including warranties of 
merchantability or fitness for any use or any particular purpose with regard to the 
Software and documentation.  The Software and documentation are licensed to 
Purchaser on an AS IS basis.  Liability of McKesson will be strictly limited to the 
purchase price of the Software in any case. 
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IN NO EVENT SHALL MCKESSON BE LIABLE FOR ANY DIRECT, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, INCLUDING, BUT NOT 
LIMITED TO, LOSS OF PROFITS, LOSS OF BENEFITS, OR LOSS OF DATA 
RESULTING FROM THE USE OF THIS SOFTWARE OR ARISING OUT OF 
ANY CLAIMED OR ACTUAL BREACH OF WARRANTY.  Some states do not 
allow the exclusion or limitation of direct, incidental, or consequential damages.  If 
Purchaser resides in such a state, the above limitation may not apply to Purchaser.  

NO OTHER REPRESENTATIONS OR WARRANTIES CONCERNING THE 
SOFTWARE OR DOCUMENTATION MAY BE GIVEN EXCEPT THOSE 
CONTAINED HEREIN. 

Termination of License 
McKesson may terminate this License Agreement upon a breach by Purchaser of any 
term hereof.  Upon such termination by McKesson, Purchaser agrees to immediately 
return to McKesson or destroy all copies of the Software in Purchaser’s possession. 

Miscellaneous 
The failure of McKesson to enforce any rights granted hereunder or to take any action 
against Purchaser in the event of a breach hereunder shall not be deemed a waiver by 
McKesson as to subsequent enforcement of rights or subsequent actions in the event of 
future breaches.  Neither this License Agreement nor any interest in this License 
Agreement is assignable by Purchaser.  This License Agreement represents the entire 
agreement concerning the Software between Purchaser and McKesson.  Should any 
term of this License Agreement be declared void or unenforceable by any court of 
competent jurisdiction, such declaration shall have no effect on the remaining terms 
hereof.  This License Agreement shall be construed and governed in accordance with the 
laws of the State of Georgia, United States of America. 
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Chapter 1 
 

Introduction 
Starting the Program 
Click the Office Hours icon on your computer desktop or go to the Start menu in the 
Task bar and select Programs.  A drop-down list showing all the programs installed in 
your Windows Operating System is displayed.  Select Medisoft.  If Office Hours has 
been properly installed, it will be one of the choices under the menu.  Select Office 
Hours Professional to open the program.  If you are using Office Hours Professional 
integrated with any Medisoft program, you can also click the Appointment Book Speed 
button in the Speed bar of the Medisoft program.   

Office Hours can be easily accessed at the same time you are working in other 
Windows-based programs.  Open Office Hours at the beginning of each day and then 
minimize it.  Hold down the ALT key while pressing the TAB key repeatedly to 
produce a small window that takes you through all the icons for the open programs on 
your computer.  Lift your fingers off the keys when the black rectangle surrounds the 
Office Hours icon, and the program will activate.  You can then perform the desired 
scheduling tasks, minimize the program, and return to your previous task. 

Office Hours Professional Stand-Alone Setup 
The first time you open Office Hours Professional, the Find Medisoft Database 
window appears.   

 

Enter the root data directory or click Browse to locate the directory.  If you use the 
program on a network, you can enter the UNC address of the shared folder (e.g., 
\\ServerName\FolderName).  If you use the UNC address, you do not need to map a 
drive and use the drive letter to access your data.  Click OK.     

 If you do not use Office Hours Professional on a network, uncheck the Use 
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UNC Address box. 

After you enter the root data directory, the program opens the Create Data window.  
You have two options: create a new set of data or convert previous Office Hours data. 

 

If the root data directory you enter is brand new, a message will appear telling 
you it is not an existing root data directory and then ask if you want to create a 
new one.  Click Yes to accept the directory as your root data directory.  Click 
No to go back to the Find Medisoft Database window. 

Create Data 
Click Create a New Set of Data, and the Create a New Set of Data window appears.  
Click the window and, in the spaces provided, enter the practice name and practice data 
directory.  Then click Create.   

After you create your data set, the program will indicate that you need to create a 
provider for the practice.  Enter the provider information in the Provider window that 
appears and click Save.  Then you can move about the program. 

F1   Look up Provider Entry. 

Convert Data 
Click Convert Windows Office Hours Data, and the Medisoft File Conversion 
window appears.  Click Search for Data  to search your physical hard drive for any 
MWDBLIST.ADT files.  When found, the program lists all valid data directories in the 
window. 

 A valid data directory is one that contains data. 

Of the data sets listed in the Medisoft File Conversion window, you can select as many 
or as few as you would like to convert at one time.  There is a Cancel button available 
which, when clicked, will stop the conversion of the currently selected data directory.  If 
one data set conversion is cancelled, the program will proceed to the next selected data 
set (if there is one) and complete the conversion of all selected data sets. 

When the data sets are converted, your original data directories remain unchanged, 
except a CONVERT.LOG file (and possibly a DATABASE.CLI file) is created in each 
data directory that is converted.  The program creates a new directory for each converted 
data set in the root data directory you specified when you installed your latest program.  
The first new data directory is automatically named DATA, and the second is named 
DATA1, with each new data directory named consecutively after that (e.g., DATA2, 
DATA3, etc.).  The program relies on this naming convention to function properly.   

   DO NOT RENAME THESE DATA FILES. 
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To identify which practice files are contained in which data directory, use the Open 
Practice window, which contains the data path for the highlighted directory.  

It is recommended that you do not delete the old data directories until you know for 
certain that the newly converted data is complete.   

F1   Look up Conversion of Data. 

A Look at Office Hours Professional 
The Title bar at the top of the window shows the program name and the practice 
information.   

 

Below the title bar is the Menu bar, which is explained later.  Below the Menu bar is a 
toolbar (or Speed bar) with speed buttons (or icons) that provide quick access to most 
parts of the program.   

The program opens to a full appointment display.  The current date is fully spelled out 
in color and the actual date is highlighted on the calendar in contrasting color.   

Below the calendar are advance and reverse arrows with Day, Week, Month, and Year 
fields.  Clicking the arrow to the right of a field name will advance the calendar to the 
next day, week, month, or year.  The arrow on the left side takes you back to the 
previous day, week, month, or year.   
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The main portion of the window is the appointment grid, where appointments and 
breaks appear.  Above this grid, in the toolbar, is the provider box with a drop-down list 
that includes the current providers set up in the program. 

The lower left portion of the window displays the details of any selected appointment or 
break.  When you click an appointment or break on the grid, information about that 
appointment or break appears in this area.   

At the bottom of the window, in the Status bar, are four squares with various dot 
patterns that provide quick access to different appointment views.  The first, with one 
dot, opens a Single Provider grid, showing those appointments scheduled for the 
selected provider on the day highlighted on the calendar.  The second box, with three 
dots in a row, opens a full week’s schedule.  The third box shows a full month’s 
appointments.  The last box displays any combination of provider and resource 
columns, each variation of which is called a Multi View.  Various combinations can be 
set up in Program Options (File Menu). 

Menu Bar 
The Menu Bar, found under the Title bar, contains various menus which list the 
activities available in Office Hours.   

 

Clicking any of the menu headings, such as File or Edit, or using the accelerator keys 
opens a submenu with all the options available from that menu.   

 File Menu 
Within the File menu are options to open new or existing appointment books.  
There is also an option to convert data.  Select Program Options to set basic 
program options.  File Maintenance, Backup Data, Backup Scheduler, and 
Restore Data are important tools for managing your database files.  Security Setup, 
when applied, causes two more options to appear in the File Menu: Permissions 
and Log in as another user.  There are also the options to use Office Messenger 
(integrated with Medisoft Network Professional only) and to Exit the entire 
program.   

 Edit Menu 
Besides the usual options to Cut, Paste, Copy, and Delete, the Edit menu provides 
access to such functions as Go to Today, Go to Date, Find Open Time, and Find 
Next Open Time. 

 View Menu 
The View menu lets you decide what portions of the calendar to display.  You can 
display or hide the Calendar, Status Bar, Toolbar, the template Legend, and/or the 
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Wait List.  This menu gives you access to Zoom In, Zoom Out, or Zoom to select 
your own setting for closer or more general looks.  You can Revert to Default View 
settings or Refresh the calendar, to bring it up to date with the changes that have 
been made.  You can Edit View or Save View.  The menu also gives access to the 
Day View, for a look at a single provider’s appointments for one day; Week View, 
to show the week at a glance; Month View, which shows booked times for the full 
month; and Multi View, which displays any configuration of provider and resource 
columns in one grid window.  Lastly, you can Edit Templates from this menu. 

 Lists Menu 
Under the Lists menu, you can display the Appointment List, Break List, Patient 
List, Provider List, Resource List, Reason List, Template List, Patient Recall 
(integrated only), and Superbill Tracking List.  

 Reports Menu 
The Reports menu gives you access to the following options:  Appointment List, 
Appointment Status, No-Show Report, Print Appointment Grid, Print Superbills 
(integrated only), Appointment Analysis by Provider, Appointment Analysis by 
Reason, Templates, Reasons, and Waiting Appointments.  You also have access to 
the Custom Report List (integrated only), Load Saved Reports, and Design 
Custom Reports and Bills (integrated only). 

 Tools Menu 
The Tools menu provides System Information. 

 Help Menu 
The Help menu includes access to the Office Hours Help, Show Balloon Hints, 
Clear Custom Grid Settings, Clear Window Positions, Medisoft on the Web, 
Online Updates, and About Office Hours. 

Speed Buttons on the Toolbar 
Below the Menu bar, there are speed buttons (or icons) on the toolbar that give you 
quick access to various functions of Office Hours, such as setting appointments and 
most of the search functions.   

 

The speed buttons are illustrated to facilitate easy recognition of their functions.  

  The Appointment Entry button lets you set up an appointment.   
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  The Break Entry button opens the setup window for creating a break.  

  The Appointment List button displays the current appointment schedule.  

  The Break List button prints out the breaks that have already been set up.  

  The Patient List button accesses the Patient List window.    

  The Provider List button accesses the Provider List window.    

  The Resource List button shows all treatment and examination rooms or labs. 

  The Patient Recall button opens the Patient Recall List window (integrated 
only). 

  Go to a Date lets you set up guidelines for searching for a patient.  

  Search for Open Time Slot triggers a search for an opening in the schedule, as 
per guidelines or parameters you establish. 

  Search Again renews the search in a more extensive manner.   

  If you are scheduling in another part of the calendar, the Go To Today button 
takes you right to the current day’s list of appointments.  

  The Edit Templates button puts the Appointment Grid in a modification mode 
to edit templates. 

   The Print button prints the Speed Report designated in the Program Options 
window. 

  The Help button opens the Help file’s Table of Contents, from which you can 
choose the area in which you want more information.  The F1 key takes you 
directly to the Help files pertaining to the part of the program in which you are 
working.  
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    This button launches FinalDraft, a word processing application. 

  The Exit button closes down the entire program. 

Four View buttons in the status bar at the bottom of the window take you to the Single 
Provider, Week, Month, or Multiple Provider/Resource View appointment grids.   

 

The Status bar displays a written summary of the functions of the speed button or field 
on which the cursor is resting.  It also displays, if security has been applied, who is 
logged in to the computer. 
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Chapter 2 
 

Set Up 
Before You Start Scheduling 
There are several portions of the program that have to be set up before you start 
scheduling.   

 
If you use Office Hours Professional integrated with Medisoft, all the records 
you enter in Medisoft will be accessible in Office Hours Professional. 

• First, set up provider records.  If you are booking appointments for lab work or 
therapy, each of those technicians should have a provider number and schedule and 
so should each office member whose schedule will be included in the Office Hours 
program. 

• Second, set up your patient records.   

• Third, create your resource records.  You can include all treatment apparatuses in 
this list, as well as consultation and treatment rooms, so that you do not double 
book a room or equipment. 

• Fourth, establish the number of booking columns you want. 

• Fifth, clarify program options, such as establishing appointment length, creating 
whatever views you need for viewing multiple columns at once, and deciding how 
much information you want displayed in your appointment blocks in the 
appointment grid.   

• Sixth, set up breaks and recurring breaks, to show lunch hour, set coffee-type 
breaks, seminars, etc. 

• Seventh, set up the security feature. 
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Setting up Provider Records 
A provider record must be set up before Office Hours can run.  If no provider record is 
set up, Office Hours will automatically prompt you to do so.  You can let the program 
assign the Code for the provider or you can enter a five-character code yourself.  Enter 
the provider’s name and pertinent information.   

F1   Look up Provider Entry. 

Setting up Patient Records 
Click the Patient List speed button or go to the Lists menu and select Patient List.  
Click New or press F8 to display the Patient/Guarantor: (new) window.  Create a chart 
number yourself (eight alphanumeric characters) or let the program create one.  Enter 
information in as many of the fields as necessary in both tabs.  When finished, click 
Save.  Repeat this process for each patient who visits your practice. 

F1   Look up Patient Entry. 

Setting up Case Records (Integrated only)   
You can create case records in either Medisoft or Office Hours.  Click the Patient List 
speed button and then choose the Case radio button in the top-right corner of the 
window.  Then click New Case or press F8 to display the Case: Patient Name (new) 
window.  Enter information in as many of the fields as necessary.  When finished, click 
Save.  Repeat this process for each case you want to enter. 

F1 Look up Case Entry. 

Setting up Resource Records 
The Resource List is a tool to help you manage the scheduling of rooms and equipment 
in the office.  To create the list, click the Resource List speed button or go to the Lists 
menu and select Resource List.  In the Resource List window, click New or press F8.   

 

Create a code for the resource or let the program create one based on the description.  
Enter a description (e.g., Room 1, Treadmill, etc.) and click Save.  Repeat this process 
until all rooms and/or equipment are contained in the list. 

F1   Look up Resource Entry. 
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Multiple Booking Columns 
If you want to multi-book appointments (that is, schedule more than one patient in the 
same time slot), simply right-click the column heading in the appointment grid and the 
Speed menu will give you a choice of Add Column or Delete Column.  If you add a 
column, the Add Column window has a horizontal scroll bar that lets you indicate the 
provider for whom you are adding a column.  The number of columns determines how 
many appointments can be booked in one time slot for one provider.  There is really no 
limit as to how many columns can be set up on the appointment grid.  You can also edit 
the column display by selecting Edit Column in the Speed menu.  Changes are made in 
the Change Column window. 

F1   Look up Multiple Appointment Booking. 

Program Options 
 Appointment Length 

Set the starting and ending appointment times for the practice.  Enter the Starting 
Time and Ending Time, breaking it down by hour and minutes.  Standard 
appointment Intervals can be established by scrolling with the up and down 
arrows.   

 

You can also set colors to distinguish appointments, breaks, and conflicts.  Make 
decisions concerning all the other default settings in this tab. 
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Designate one of the reports in the Speed Report box and it will automatically 
print when you click the Print speed button. 

You can now choose to use Deposit Entry or Transaction Entry when entering a 
copay.  To use Transaction Entry rather than Deposit Entry, click the Use 
transaction Entry to Make Copays check box.  This is only available when Office 
Hours Professional is integrated with a version of Medisoft. 

 Views 
One of the most important features of the Office Hours Professional program is the 
variety of ways you can display appointments/breaks in the appointment grid.   

At the bottom of the main Office Hours window, in the Status bar, there are four 
View boxes, with different configurations of dot patterns.  These give quick access 
to the same functions available through the View menu on the Menu bar.  These 
correspond to Single Provider View, Week View, Month View, or any combination 
Multi View.   

Day View 
The Day View shows a single provider’s appointments for a selected day.  If 
multiple columns are set up, all columns are displayed.  To display another 
provider’s schedule, make a new selection in the provider box in the toolbar.  This 
view does not show columns for resources, but columns can be added or removed 
as necessary in this view.   

Week View 
The Week View also shows only one provider’s schedule, but with one column for 
each day of the week.  If you have multiple appointments scheduled, the time slot 
will show the color for scheduling conflicts.  You can size the columns to see all the 
appointments/breaks scheduled by placing the cursor on the right column heading 
boundary line until it takes the shape of a double-sided arrow , and then drag 
the boundary line right or left to increase or decrease the size of the column.  
Columns can be added or removed as necessary in this view. 

Month View 
The Month View shows up to 31 days, with the boxes colored where appointments 
have been scheduled.  This is a single-provider view.  The value of this view is that 
you can get a good overall view of which days are free for appointments or other 
scheduled items.  Columns cannot be added or removed in the Month View. 
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Multi View/Multiple Provider/Resource View 
The Multi View, or Multiple Provider/Resource View, is the most flexible.  The 
program provides one Multi View setup, which automatically includes all providers 
and all resources, each with its own column.  You can create as many Multi Views 
as you need in the Multi Views tab of Program Options.    

 

The open data entry field lists all Multi Views that have been set up.  This is where 
you can group providers and/or resources (rooms or facilities scheduled for 
appointments) in any combination desired, or modify or delete existing multiple 
view setups.  Click New to set up a new Multi View (select a view and click Edit to 
make changes).   

In the New View window, assign a name for the new view.  For the first column, 
indicate the type (Provider or Resource), the Code (provider number or resource 
code), then the width of the column (in pixels).  Set up each column you want in 
the view and click Close when finished.   

If you want to add a column between columns that have already been created, place 
your cursor where you want the new column and click Insert.  

These views can be also edited or reverted to default views through the View menu. 

Appointment Display 
In the Appointment Display tab of Program Options, you can specify up to five 
rows of information to display in the grid for an appointment.  Be aware that the 
length of the appointment determines how much data is actually displayed on the 
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grid.  An appointment must be at least 75 minutes long to display five rows of 
information. 

F1   Look up Program Options. 

Setting Breaks 
You can enter breaks into the appointment schedule as reminders that the time slots are 
committed.  Some breaks are a one-time occurrence, like a vacation or a seminar.  
Others are regularly scheduled times for each month or week.         

There are several ways to access the New Break Entry window.  The quickest way is to 
click the Break Entry speed button.  You can also click New or press F8 in the Break 
List window. 

To create a break, give it a name, a date, and enter the time that the break will start.  
Using the up and down arrows, enter the length of time in minutes.  The display color 
of the break should be contrasting to the regular daily appointment schedule (the 
default is gray).  

Indicate whether the break should display in all columns on the appointment grid.  If 
not, click the All Columns box to uncheck it, and then mark those columns to be 
affected.  Three radio buttons at the bottom of the window let you apply the break to 
the Current provider (the one whose schedule is on the window), Some, or All 
providers.  

F1   Look up New Break Entry. 

When used with Medisoft, users can set the permission levels (Level 1 through Level 5) 
for appointment breaks through the Medisoft Security Permissions window. Users can 
view and set new permissions and edit or delete permissions for the five levels of 
security. 

The default setting for Appointment Breaks is the same as for Appointments. Refer to 
the Office Hours online help for instructions on changing permission levels in Medisoft. 

Setting Up Repeating Breaks 
In the New Break Entry window is a field marked Repeat, with a Change button.  
Clicking Change opens the Repeat Change window where you can establish the 
Frequency of the break.   
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Choosing any of the radio buttons (except None) displays different data entry boxes in 
the middle of the window that give you the repeat options for each frequency.  Also, a 
written summary of the selected frequency appears in the bottom middle area of the 
box. 

It is important to note that when you set up a break using the Monthly frequency, the 
date highlighted on the main calendar will have an effect on the day or date that is 
entered in the break note.     

Security Setup  

 

Set up security at a time when no one else is using the program.  After security 
levels have been established, the program must be closed and opened again 
before the feature is activated.  Until the feature is activated, any user can 
change or alter any information contained in the program. 

If you are using Office Hours Professional in connection with any Medisoft patient 
accounting program, the security settings established in the patient accounting program 
are applied to Office Hours Professional as well.  However, you can make changes from 
within Office Hours if needed.  

 

 

 

To set up security, go to the File menu and select Security Setup.  The Security Setup 
window opens. 

Click New or press F8 to activate the User Entry window.  Since the Security 
Supervisor has unlimited access and full control of security, set up that user first.  Enter 
the Supervisor’s Login Name, Full Name, Password, and Access Level.  Be sure the 
Supervisor’s access level is 1.  Reenter the password.  Since you are setting up the 
Supervisor record, you probably won’t use the Inactive or Expire Date fields yet. 

Open the Question tab.  Apply a security question to help verify the user when he or she 
cannot remember the password.  Click Save.   
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Each user can also be assigned to a group through Security Setup.  Grouping users by 
job function or security level can help you easily assign tasks or send messages to a 
number of people at once.  To create a group, select the Group tab in the Security 
Setup window.  Click New.  The Security Group window opens.  Enter a Group ID, 
Group Name, and a brief Description so that one group can be easily distinguished 
from another.  Click Save.  

To assign a user to a group, click the User tab in the Security Setup window.  Highlight 
a user’s name.  Click Edit, and then select the Group tab.  Click the check-box next to 
the group you want to assign the user to.  Click Save, then close the Security Setup 
window by clicking Close. 

The Supervisor can then create/revise the rights of each level of security.  Go to the File 
menu and select Permissions to open the Medisoft Security Permissions window. 

Medisoft security consists of five levels of program rights and/or access.  Each window 
within the program is listed in the Window section of the grid.  A checkmark under a 
level heading means anyone with that level of security has the ability to perform that 
task and have access to that portion of the program.   

It is the responsibility of the Supervisor to assign or remove rights for any level of 
security, with one exception.  Level 1 access for the supervisor cannot be removed from 
any of the options listed in the Security window settings.  Lower level access can be 
added, but the Supervisor must retain rights to these options. 

Level 1 is for unlimited access and is designed to be used exclusively by the Supervisor or 
administrator to restrict access to the program.  Levels 2, 3, 4, and 5 can be user-defined 
with the Supervisor deciding what fits in what level and assigning users accordingly.  
Generally, the higher the level number, the fewer rights are assigned to it.  Add or 
remove checkmarks for level access by clicking the appropriate check box for each 
process displayed with each listed window name. 

You can access the Medisoft Security Permissions window at any time to make 
changes.  However, the program must be restarted on each computer before any changes 
become effective.  After the permissions have been set up, the Supervisor needs to return 
to the Security Setup window and enter all other users, assigning each the correct level 
of security.  Follow the same procedure as that used for setting up the Supervisor. 

The Inactive field can be used to immediately block a user’s access.  The Expire Date 
field is useful for temporary employees.   

Once you use the security feature, the File menu contains an additional option, Log In 
As Another User.   

If a user attempts a task for which he or she does not have security clearance, a security 
warning displays.  This security block can be temporarily overridden and someone with 
the proper clearance level can log in to give the first user the clearance to complete the 
task.  Be sure to cancel the temporary override when the task is completed.   
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If desired, Level 1 users can also set up and apply the Global Login feature. The Global 
Login function provides an extra layer of security and added convenience for users that 
access multiple practices and applications. The Global Login features works with 
standard security to provide a path that determines what practices users can access. The 
feature utilizes standard security and permissions that determine what users can access or 
do in individual practices but then provides a method for users to logon once and then 
access all practices associated with the global user—essentially, once the feature is set up, 
a single user may access multiple practices without having to login to each dataset 
separately.  

F1   Look up Security Setup. 

F1   Look up Global Login Overview. 

 

Setting Up Multiple Practices (Stand-Alone Only)  
 

 If integrated, set up multiple practices in your Medisoft program. 

When you set up a practice in Office Hours, the program assumes it is a single practice 
and sets up a default directory for the data within that practice.  Each time you set up 
additional practices with totally unrelated patient files, different subdirectories are 
created.  To set up a new practice, go to the File menu and select New Practice.  This 
opens the Create a New Set of Data window.  Type the information for the new 
practice in the window.  It is not necessary to install the Office Hours program for each 
practice.  If you set patient appointments for several practices, you can move freely from 
one data set to another by going to the File menu and selecting Open Practice.  Then 
you can select the desired database from the list. 

F1   Look up Setting Up Multiple Practices.
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Chapter 3 
 

Using Office Hours Professional  
Setting an Appointment 
To set an appointment in Office Hours, first select the provider for whom you are 
scheduling.  In the Day, Week, and Month views, the provider box at the top right of 
the toolbar has a drop-down box arrow.  Select the provider you need, or press F8 to set 
up a new provider record.  In any Multi View, select the provider by clicking in the 
appropriate provider’s column. 

Select the date on which the appointment is to be set.  You can use the Day, Week, 
Month, and Year selection arrows below the calendar to locate the correct date or use 
the Go to Date feature.  

Next, in the appointment grid, double-click a time slot, which will be highlighted with a 
heavy line border.  You can also click the New Appointment speed button; right-click in 
the time slot and select New Appointment; press F8; or go to the Lists menu and select 
Appointment List, then click New to open the New Appointment Entry window.   
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Enter or select the Chart Number of the person for whom the appointment is being set.  
If the person’s information has been entered in the program, the name and phone 
number will be automatically entered and the patient’s last case will be reflected in the 
Case field.   

 
If you are setting an appointment for a non-patient, skip the Chart field and 
enter the person’s name in the Name field. 

Assign a resource.  If the resource or room you need is not in the list, press F8 to create a 
new resource record.  The Notes field lets you include a reminder message regarding the 
patient’s need or condition.  Enter an appointment reason in the Reason field.  If 
necessary, change the Length, Date, and Time fields here.  You can also change the 
appointment color.  If there is a need for repeat visits, click Change in the Repeat 
section.  See the Repeating Appointments section later in this chapter, page 21. 

Select the correct status.  Click the Need Referral box if applicable. 

You can make a deposit entry directly from this screen if your Office Hours program is 
integrated with Medisoft Advanced or Network Professional.  Click Enter Copay.   

F1   Look up Appointment Entry. 

Finding Available Appointment Space 
To find an appointment slot that fits the time and length desired, go to the Edit menu 
and select Find Open Time or click the Search for Open Time Slot speed button.  In 
the Find Open Time window, first enter the length of time for which you want to 
search.  If you have a certain time frame in which you want to find an appointment, 
enter the Start Time and End Time.  Check boxes let you indicate the day(s) of the 
week on which you want to find an appointment time.  Then click Search. 

If the time slot turned up is not sufficient or does not meet the patient’s needs, select 
Find Next Open Time or click the Search Again speed button. 

Locating a Future Date 
There are times when the doctor wants to see the patient again in two weeks or another 
time in the future.  The quickest and easiest way to get to that specific time is to click 
the Go to Date speed button.   

In the Go To Date window, indicate the date from which you want to calculate the date 
in the future (e.g., last Friday).  Then indicate the number of Days, Weeks, Months, 
and/or Years from that date.  The entries can be cumulative.  It is possible to enter one 
month, two weeks, and four days, if the goal date is 48 days away.   

 You can also go backward through the calendar by entering negative numbers. 
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Repeating Appointments 
When a patient needs to make regular return visits, set up repeat appointments through 
the New Appointment Entry window, if just setting up the appointment, or through 
the Edit Appointment window, if the appointment has already been set up and you 
need to add repeating appointments.  Click Change in the Repeat section at the bottom 
of the window.  The Repeat Change window that opens is the same window that 
appears when creating repeating breaks.  See the Setting Up Repeating Breaks section 
in Chapter 2, page 14. 

F1   Look up Repeating Event. 

Viewing Future Appointments 
In Office Hours, you are now able to view all appointment scheduled for a patient.  To 
view future appointments for a patient, right-click the patient’s appointment in the 
appointment grid.  Select Future Appointments.  The Future Appointment List 
appears displaying all up-coming appointments scheduled for the selected patient. 

F1   Look up Future Appointment List. 

Changing or Deleting an Appointment 
 Changing Appointment Status 

There are multiple options for marking the status of an appointment.   

 

The default is Unconfirmed.  When any change in status occurs, edit the 
appointment or right-click on the appointment and choose the appropriate radio 
button.  If you choose Cancelled, the appointment is removed from the grid 
display.  Any other status is reflected by a small icon in the upper right corner of 
the appointment in the grid.   
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 Moving an Appointment 
If you want to move the appointment to another day or time, click the 
appointment and press CTRL + X (or go to the Edit menu and select Cut).  Move 
the cursor to the new day and/or time slot, and either press CTRL + V or select 
Paste in the Edit menu.  If you want to move the appointment to another time slot 
showing on the appointment grid (whether the same provider or not), click the 
appointment, hold the left mouse button down and drag the cursor to the desired 
time slot.  Release the mouse button.  

 Rescheduling Appointments 
Office Hours Professional provides users with an easy-to-use method for 
rescheduling appointments. Users can open an appointment and change the 
appointment status to rescheduled. The system then opens the Wait List. From the 
Wait List users can use the Find function to search for an open appointment based 
on selected Criteria. 

To Reschedule an Appointment  

1. On the Appointment List right-click the desired appointment to 
reschedule. The Wait List window appears. Go to step 4. 
 
-Or- 

2. On the Appointment List double-click the desired appointment to 
reschedule. The Edit Appointment window appears.  

3. On the Edit Appointment window from the Status panel, click the 
Rescheduled radio button. The Confirm window appears. 

4. On the Confirm window click the Yes button. The Wait List 
window appears. 

5. On the Wait List window click the Find button. The Find Open 
Time window appears. 

6. On the Find Open Time window select/modify criteria for selecting 
a new appointment. Click the Search button. The Confirm window 
appears. 

7. On the Confirm window click Yes to set the appointment or No to 
reject the appointment. Click Retry to for the next available 
appointment. 
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 Deleting an Appointment 
There are multiple ways to delete or remove an appointment: (1) click the 
appointment slot on the appointment grid and press DELETE;  (2) highlight the 
appointment in the Appointment List and click Delete; or (3) right-click the 
appointment (either in the Appointment List window or on the appointment grid) 
and select Delete or Delete item, respectively.  You can also edit the appointment 
and change the status to Cancelled.   

F1   Look up Moving/Deleting an Appointment. 

Patient Recall (Integrated only)  
The program includes a complete patient recall system with a recall appointment list to 
assist in contacting patients to schedule appointment dates and times or to make 
reminder phone calls.  This feature is available through both the Medisoft and Office 
Hours programs. 

F1   Look up Patient Recall. 

Finding an Existing Appointment 
To search for an existing appointment, click the Appointment List speed button.  The 
Appointment List appears.  Use the Search and Field data fields to locate the patient for 
whom you are searching.   

 

Entries within the parameters of your search are displayed in the window.  As you 
highlight a patient name on the list, right-click to display a Speed menu that will let you 
Edit Item, enter a New Item, Go to Item (which takes you immediately to that 
patient’s appointment), and Delete Item.  

F1   Look up Printing the Appointment List. 
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Returning to the Current Date 
If you need to get quickly back to today’s appointment schedule, no matter where you 
are in the program, click the Go to Today speed button to bring you back to the current 
date. 

Exiting Office Hours 
Exit Office Hours by clicking the Exit speed button on the toolbar.  This closes all the 
files opened by Office Hours and exits the program.  Office Hours can also be exited by 
clicking the Close button (the third of the three small boxes in the upper right corner), 
by selecting Exit in the File Menu, or by pressing ALT + X. 

If you don’t want to close Office Hours, but want to work in another Windows-based 
program, you can minimize the Office Hours program by clicking the Minimize button 
(the first of three small boxes in the upper right corner of the window).  “Minimize” 
means reducing Office Hours to a button on the Task bar. 

 



 
 Chapter 4:  Reports    25 

Chapter 4 
 

Reports 
Appointment List 
Probably the most important report printed in Office Hours is the Appointment 
Schedule, a listing of all the day’s scheduled events.  Generally, printing this report is the 
first order of business.  Print the list and be sure you are ready to meet the day.  

F1   Look up Printing the Appointment List. 

Appointment Status  
The Appointment Status Report shows all the appointments scheduled for a certain 
time period and their assigned statuses.  It also displays a sum of how many 
appointments are assigned to each status.  This report gives you an idea of how statuses 
are being used in your practice.   

F1   Look up Appointment Status Report. 

No-Show Report 
Keeping track of patients who do not come in for their appointment can be almost as 
important as billing those who do.  Following up on patients who do not show up for 
their appointments can show that you care about their condition.  If the patient simply 
forgot the appointment, it can be rescheduled for a later time.   

The No-Show Report, selected from the Reports menu, is compiled based on the use of 
the Status radio buttons in the appointment setup.  If you don’t update appointment 
status, the No-Show Report is not functional.  This report can be limited by a specified 
range of dates and/or providers.  It lists the patient, his or her phone number, Chart 
Number, appointment date and time, assigned resource, provider, and status. 

F1   Look up No-Show Report. 

Appointment Grid 
When you print the appointment grid, the program gives you a hard copy of the current 
view in the Office Hours window.   
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As you go to the Reports menu, select Print Appointment Grid, and then choose if you 
want to see it In Grid View or In List View.  The Report Setup window will open.  
After you set the report options, the program prints whatever view is currently displayed 
in the appointment grid. 

F1   Look up Print Appointment Grid. 

Print Superbills (Integrated only) 
If you use Office Hours Professional integrated with any version of Medisoft, you can 
print superbills for the day through Office Hours.  Go to the Reports menu and select 
Print Superbills.   

F1   Look up Printing the Superbill.   

Appointment Analysis by Provider 
The Appointment Analysis by Provider summarizes the appointments and treatments by 
the practice, based on the provider.  This report analyzes the revenue generated by each 
provider, how many patients each provider sees, etc.   

F1   Look up Appointment Analysis by Provider Report. 

Appointment Analysis by Reason 
The Appointment Analysis by Reason report summarizes the appointments and 
treatments based on the Reason, with a sub list of providers who see patients for that 
Reason. 

F1   Look up Appointment Analysis by Reason Report. 

Templates 
This report lists, by provider, the templates created, including the date, time, length and 
description, color selected, and repetition of the template.  A template lets you isolate 
areas on the appointment grid for special reasons.    

F1   Look up Printing the Template List. 

Reasons  
This report lists reason codes and descriptions, default length and the color designated 
on the appointment grid for the appointment and also for the template. 

F1   Look up Printing the Reason List. 
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Waiting Appointments  
The Wait List keeps track of patients by provider, the date entered, patient name and 
phone number, the reasons, and estimated length.  It also shows the resource where the 
examination is scheduled to take place.  

F1   Look up Printing the Waiting Appointments List. 

Custom Report List (Integrated only) 
Design capabilities in the program let you generate a variety of custom reports that meet 
the needs of your practice.  Customized reports are accessed through the Custom 
Report List in the Reports menu.  When you create a customized report, it is included 
in the Custom Report List. 

F1   Look up Custom Report List. 

Design Custom Reports and Bills (Integrated only) 
The custom design capability lets you determine what data you want in the new report 
or bill and how it should be displayed.  You have formatting power to decide on style 
and determine the layout and content display.   

F1   Look up Design Custom Reports and Bills. 

Load Saved Reports 
This option lets you reopen reports that were prepared earlier and have been saved 

F1   Look up Load Saved Reports.
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Chapter 5 
 

Miscellaneous 
Office Messenger (Integrated with Medisoft Network 
Professional only) 
Office Messenger is a simple way to send a quick message to someone else using the 
program.  All you need to know is the name of the computer to which you want to send 
a message.   

F1   Look up Medisoft Office Messenger. 

System Information 
In the Tools Menu, System Information lists operating systems, range of printers 
available, drive, CPU, and memory range. 

File Maintenance 
Within Office Hours, you can rebuild indexes, pack data, and purge Office Hours data.  
Each of these file management functions can take a long time to process.  It is 
recommended that you do not perform File Maintenance functions during working 
hours, when your computer is needed for office management and accounting. 

 
If you are using Office Hours integrated with any Medisoft program, any file 
maintenance performed in Office Hours affects both the Office Hours and 
patient accounting programs. 

Rebuild Indexes 
The Rebuild Indexes tab lists those files which can be rebuilt.  Select the file type you 
want to rebuild or click All Files to include them all. 

Pack Data 
Open the Pack Data tab to choose the type of files from which you want to remove data 
deleted from use in the program but not yet deleted from the files.  Here again, you can 
choose one type of files or select All Files to include them all. 
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Purge Data 
Purging a data file removes data records you no longer need.  The decision to purge data 
files should be made only after careful consideration.  You cannot access purged data 
unless you have a previous backup disk containing the files, but this will also replace all 
your program data files with the backup files.  Be careful when purging data.  You can 
purge appointments in the Appointment Grid or in the Wait List.   

 You cannot access data purged from the program. 

Select the data to be removed by checking the appropriate check box, then entering a 
cutoff date.  All data in the selected file(s) before and including the date specified will be 
deleted. 

F1   Look up File Maintenance. 
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Appendix A 
 

Where to Find Help with Office Hours 
The Manual 
Documentation Conventions 
As steps required to use the program are explained, certain consistent instructions are 
given in the manual.  Knowing these instructions will help you have a clearer 
understanding when they are used. 

 Buttons, Keys, and Title Designations  
For identification purposes, all buttons, keys, menu selection options, windows, 
and fields mentioned in the manual are in bold print (File menu, Program 
Options, Delete). 

 Entering Information 
When you are instructed to enter information, type the data, then press ENTER.  
For example, the instruction to “enter your name” means to type your name and 
press ENTER.   

When instructions say an entry can be alphanumeric, it can be letters, numbers, or 
a combination of both.  In most cases, a chart number is alphanumeric, a 
combination of letters and numbers. 

When instructed to enter a date or phone number, use no punctuation.  The 
program will supply the punctuation automatically.  For dates, use the format of 
either MMDDYY or MMDDCCYY (for Medicare claims only). 

Support Options 
Technical help for learning and working with Office Hours is available in the following 
options:  (1) F1 key or Help buttons access online information while within the 
program; (2) accessing the Medisoft web site; (3) training options; (4) local Value-
Added Resellers; and (5) telephone technical support.  Support is unable to provide 
training on the telephone.   
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Using Online Help 
No matter where you are in your Office Hours program, help is close at hand.  If you 
don’t understand what is wanted, or how data should be entered, press F1, click Help (if 
available), or click the Help speed button, and data files are opened.  Specific 
information and examples of how data should be entered will be displayed in the Help 
window. 

In addition, you can go to the Help menu and select Table of Contents.  Highlighting 
any option in the Contents list will open the related help data fields.   

Regardless of which of these entry points you utilize, you open the same Help files.  
Access the files in the manner most convenient to you.   

Medisoft Web Site 
The Knowledge Base is a searchable online database containing technical information 
relevant to the use of all Medisoft and related products.  If you are working in a 
Medisoft program, access is made easy by going to the Help menu and selecting 
Medisoft on the Web or at the following web site:  

  http://www.medisoft.com/kb   

When accessed, you can search for information concerning all Medisoft products or any 
particular product.  All current technical information is contained in the Knowledge 
Base.  For instructions on how to use the Knowledge Base, click Help on the left side of 
the Knowledge Base page.   

Training Options 
There are various training options available.  Contact your sales representative at (800) 
333-4747 or a local Value-Added Reseller for information concerning these options. 

Local Value-Added Resellers 
There are local Value-Added Resellers of Medisoft in your market area who are 
knowledgeable and efficient in selling, installing, troubleshooting, and supporting your 
Medisoft program.  You can contact a sales representative for the name of a qualified 
Value-Added Reseller in your area to give you hands-on help. 

Technical Support  
Call Toll-Free (800) 334-4006.  Get help when you need it with Technical Support 
services!  Support is available to answer questions and assist in troubleshooting 
problems. 
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Support answers questions related to the operation of Medisoft software in a physician’s 
office or a billing service.  Support technicians are unable to assist with network 
configuration, computer hardware problems, or training on how to do medical billing.  
Support will provide software assistance to any customer, no matter where the program 
was purchased. 

 Support is unable to provide training on the telephone. 

 When You Call Support 
You’ll get faster service if you have these items ready when you call Support:  

• The Serial Number and registration information for your software.   

• Your Medisoft customer number.  This is found on the upper right corner of 
the invoice or packing slip that came with your program.   

• A complete description of your problem or question, including the complete 
text of any error messages.   

• A major credit card if your free support period has expired.   

• It is usually necessary for you to be able to work on your computer while you 
are talking to the technical support staff, so be sure your phone is close to the 
computer. 

 Service Hours 
Remember, Arizona doesn’t change to daylight saving time.  Year around support is 
available from 6:00 AM until 5:00 PM, Monday through Friday, Mountain 
Standard Time.   

Updates and Changes 
Go to the Help menu and select Online Updates.  Any free update available will be 
downloaded to your system. 

F1   Look up Online Updates. 

There’s a wealth of information on the Medisoft web page on the Internet.  The web 
site address is www.medisoft.com.   





 
 Appendix B:  Basic Navigation in the Manual and Program      35 

 

Appendix B 
 

Basic Navigation in the Manual and Program 
How to Use the Manual 
This manual is designed to give you an overview of what the program is and how it can 
work for you.  It is not a complete how-to instruction manual.  The detailed 
instructions are contained in the online Help files. 

After a function or window is introduced in the manual, the F1 symbol tells you there is 
online help concerning the topic.  Press F1 in the program and select the suggested 
topic.  For example, the Setting an Appointment explanation in the manual briefly 
explains and shows the window, then instructs, “F1 Look up New Appointment Entry.”  
Rather than searching through the manual for additional help, press F1 in the program, 
click Search (or press ALT+S); type “New Appointment Entry”; and press ENTER to 
go directly to the information specific to this procedure.   

More information concerning the manual is contained in Appendix A, page 31. 

Search 
A search feature is included in many data fields, indicated by an icon that looks like a 

magnifying glass.  Clicking the icon  opens a Search window that contains a list of 
the fields related to the data area of the program from which the feature was accessed.   

F1   Look up Searching. 

Data Entry Process 
Entering data in the program is easy and straightforward.  Select an option from the 
menus or click a speed button or icon.  A data entry window for that function opens.   

Buttons are placed in windows for easy editing and access.  At the bottom of the Patient 
List window, for instance, are buttons for editing records, setting up new records, 
deleting records, or closing the window.  Clicking New brings up a data entry window 
that lets you set up all of the information needed to create patient records, build patient 
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ledgers and file claims, generate reports, and whatever else you need from your patient 
accounting program. 

Data entered in a field is saved as it appears on the window.  To correct data, just click 
in the desired field and the text in the field is selected.  Typing new text with the text 
selected will change the existing text.  Select a part of the text to replace just that part or 
to delete by pressing the DELETE key. 

Keyboard Specifications 
There are keys you will use in the program that control the data.  By default, both the 
ENTER and TAB keys enter typed data into the program and move the cursor to the 
next field in the Tab order.  If you want, you can deselect ENTER as a key which allows 
you to move forward through fields.  Directional arrows let you move around the page 
to line up with the space desired. 

Accelerator Keys 
Any letter underlined on the Menu bar or in drop-down lists and in some windows 
indicates the presence of an accelerator key, a keyboard alternative to a mouse function.  
Using the ALT key in combination with the underlined letter key selects that option or 
moves the cursor to that field (such as ALT+N in list windows creates a new record).  
There are also accelerator keys that utilize the ALT and SHIFT keys in combination 
with another key (e.g., CTRL + C copies selected text). 

Function Keys 
Function keys provide shortcuts to various parts of the program.  The keys are usually 
identified by the letter “F” followed by a number from 1 to 12 and many are assigned 
specific functions within the program.  Most functions are consistent throughout the 
program, but there are a few variations.  As you get acquainted with the program, you 
will find shortcuts will speed your data entry.  Some that you will encounter are:  F1 
(Help), F3 (Save), F6 (Search), F8 (New or “add on the fly”) and F9 (Edit). 
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Appendix C 

 

Glossary 
Some of the words in this list may be familiar, but a common understanding of their 
meanings is helpful. 

Abort — To discontinue or stop the current function or process. 

Accelerator key — A shortcut key on the keyboard that can be pressed to perform a 
specific action.  Usually the ALT key in combination with another key, but can also 
be a combination of the CTRL and/or SHIFT keys with another key.  The 
underlined letter on menu items and field labels indicates an accelerator key that is 
available.  Function keys are also considered accelerator keys. 

Activate — To bring an application or document window to the foreground.  If you are 
working in more than one application or more than one document with the active 
program, the active window is the window in which you are working. 

Alphanumeric — Consisting of both letters and numbers and often other characters 
(such as a question mark). 

Application menu — The main menu of the program; displayed in a horizontal format.  
Sometimes called the operations menu or the Menu bar. 

Back up — Act of saving some or all of the data on a backup disk for safekeeping. 

Bit map — Graphic image in a window or on a computer screen.  Bit maps are made 
up of pixels.  See Pixel. 

Case — A grouping of claims usually with at least one thing in common, i.e., the same 
carrier, the same diagnosis, etc. 

Chart Number — An eight-character control number to a patient’s information. 

Check box — A square box with associated text that represents a choice.  When you 
select a choice, an X or check mark appears in the box to indicate that the choice is 
in effect. 
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Choose — To execute and complete a command.  Some commands are executed when 
you select the menu command; others execute when you choose OK in a window 
or dialog box. 

Click — To place the mouse pointer at the desired location and then quickly press and 
release the left mouse button once.  

Close button — The  button in the top right-hand corner of an active window which, 
when clicked, ends an activity and removes that window from the display.  Closing 
a program window clears the immediate program in which you are working.  See 
Exit. 

Close— The button in many windows that closes the active window but not the 
program. 

CMS  — Centers for Medicare and Medicaid Services (formerly known as the Health 
Care Financing Administration – HCFA). 

Control — A component of the user interface that allows the user to select choices or 
types of information, i.e., check box, entry field, radio button, etc. 

Cursor — A movable object (such as the flashing underline or block) on the computer 
window that indicates the position where keyboard input will appear.   

Default — A preset value in a field.   

Diagnosis Code — One of the ICD-9 (International Classification of Diseases, 9th 
revision) codes used to identify a patient’s condition.  Established by the World 
Health Organization. 

Dialog box — A moveable window containing controls that you use to provide 
information required to process a request. 

Double-click — To place the mouse pointer at the desired location and then quickly 
press and release the left mouse button twice. r 

Drag — To place the mouse pointer on an item and, while holding down the left 
mouse button, move the pointer to the desired location and then release the mouse 
button to set the item in the new place. 

Drop-down menu — A menu that emerges in a downward direction from a point or 
line at or near the top of the window.  The series of menu levels displayed 
underneath the Menu bar are pull-down menus. 

Edit control — The most common type of control for entering text. 

Exit — An action that ends the active application and removes all windows associated 
with it.  Usually click the Close  button on the program Title bar.  Many data 
windows also have Exit or Cancel buttons.  See Close button. 
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Field — The space allowed on the window for entering data, usually labeled by a field 
name, e.g., “Code Name.” 

Filter — A procedure that reads data from the keyboard, modifies the data, and displays 
it on the window, i.e., you set conditions through the keyboard, the program 
searches the database for data that fits your conditions, and displays the result on 
the window.   

Focus — The control or area of a window where user interaction is possible, where the 
data entry or action can occur or is occurring at a set point in time.  A button that 
has the focus usually has a broken line box on the button.  An edit control indicates 
that it has the focus by the blink caret (vertical cursor).   

Folder — A container in which documents, program files, and other files are stored in 
the computer or on disk.  Formerly referred to as a “directory.”   

Function keys — Keys usually identified by the letter “F” followed by a number from 1 
to 12 which provide shortcuts to accessing various parts of the program.   

Graying — A visual cue that a choice is not available at that time; a menu item or 
control is displayed in a gray color instead of black.  

Highlight — Contrasting color or reverse video (light letters on dark background) 
indicating selection of a menu option or field in a window. 

Hint — Brief summary of function displayed in a small yellow balloon when the mouse 
cursor is placed on an icon in the toolbar or on a field in a window.  Hints are also 
displayed in text form in the Status bar at the bottom of the application window.  
Also known as a ToolTip. 

Hotspot — A point of reference in a Help window that provides additional information 
concerning the picture, word, or group of words on which the cursor is resting.  To 
signify that a hotspot is present, the cursor changes to look like a hand.  Text that is 
linked to a hotspot is displayed in green. 

Icon — See Speed button. 

List box — A control that presents its data in a list format from which a user can make a 
choice.  Normally a vertical roll bar appears on the right side of the list.  Also 
known as a scroll box. 

List window — A window unique to Medisoft programs which presents each record of 
the given data file in a list format.  This window is also called a browser window, 
indicating that the data can easily be viewed and browsed through. 

Maximize — To expand the active window to fill the entire window.  The Maximize 
button is the middle of three buttons in the upper right corner of the Title bar. 

Minimize — To reduce the program to a button on the Task bar.  The Minimize 
button is the first of the buttons in the upper right corner of the Title bar.  
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Multi-booking — To schedule more than one patient appointment in the same time 
slot. 

Operation — A function in the program which may be selected from a menu. 

Operations menu — The main list of options in a program.  Also known as the 
Application menu or Menu bar. 

Procedure code — A CPT (Current Procedural Terminology) code established by the 
American Medical Association consisting of up to ten characters which identify a 
service provided to a patient.  A charge is assigned to each procedure and is 
included with the code data.  Procedure Codes are also used to record payments or 
adjustments to patient accounts.  

Provider — Usually a doctor, but may also be an assistant or nurse who renders services. 

Radio button — A circle with text beside it.  Radio buttons are combined to show a 
user a fixed set of choices from which only one choice can be selected.  The circle is 
partially filled when a choice is selected.  Also sometimes referred to as an option 
button. 

Right-click — To position the mouse pointer in the desired location and then click the 
right mouse button.  This action displays speed menus.   

Record pointer — The pointer on the left side of list windows that indicates the record 
selected. 

Scroll — To move a display image vertically or horizontally that otherwise cannot be 
observed within the boundaries of the display window. 

Select — To highlight or mark a section of text, menu name, command, dialog box 
option, or graphical object with the keyboard or with mouse actions. 

Shortcut — A quicker, more direct method of doing something than the ordinary 
procedure; usually keystrokes as opposed to using the mouse.   

Speed button — An image or picture displayed on a window to which the user can 
point to select a particular function or software application.  Also known as an icon. 

Speed menu — The menu that displays when the right mouse button is pressed, 
providing a quick and easy alternate way to execute certain commands.  This menu 
normally duplicates functions that can be initiated in other ways.   

Status bar — The gray bar across the bottom of an applications window which displays 
data and information pertaining to the field in which the user is working. 

Submenu — A menu related to and reached from a main menu; a list of options within 
the application or operations menu. 

Sub option — An option on a submenu. 
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System menu — A drop-down list that displays when the System Menu icon is selected 
(the upper left square in a window).  Usually contains items such as Restore, Move, 
Minimize, Maximize, Close, Switch To. 

Task bar — The bar at the bottom of the screen that contains the Start menu, as well as 
minimized buttons of any active program. 

Title bar — The area at the top of each window which contains the window title and 
System menu icon.  When appropriate, it also contains the Minimize, Maximize, 
and Close buttons. 

Toggle — To switch between two options, such as showing hints or not showing hints. 

Toolbar — The bar just below the Menu bar that usually contains icons or speed 
buttons to perform specific functions in the program.  See Speed button. 

Validation — A process used to detect input data in order to determine whether they 
are inaccurate, incomplete or reasonable.   

Window — An area on the computer screen surrounded by a box which contains 
information for temporary use.  Windows may be used to display information or to 
enter data.  They may include search information, help text, notes, etc. 

Windows Operating System — A graphical user interface developed by Microsoft 
Corporation wherein action is controlled by movement with a mouse or by clicking 
on icons. 
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